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1. Lwu y quan trong

Sé tay st dung dién t& nay danh cho moi
ngwdi dung st dung man hinh Philips.
Hay danh thoi gian doc sb tay st dung
nay trwéde khi s dung man hinh. Sé tay
bao gdm nhirng théng tin va cac lwvu y
quan trong lién quan dén viéc st dung
man hinh.

Ché dd bao hanh cla Philips ap dung véi
didu kién la san phdm phai dwoc s dung
dang cach theo muc dich st dung, theo
cac huéng dan hoat déng cung véi viéc
xuét trinh hoa don géc hodc bién nhan
tién mat ghi ré ngay mua, t&n ngudi ban,
mau ma va ma sb san xuét clia san pham.

1.1 Lwu y an toan va bao dwéng

® canh bao

S dung cac nut diéu khién, diéu chinh
hoac cac quy trinh khac ngoai cac quy
trinh dwoc néu rd trong tai liéu nay cé thé
khién nguwoi dung dé bi dién giat, gap cac
rGi ro vé dién va/hoac co hoc.

Hay doc va thuc hién theo cac huéng dan
sau khi két ndi va str dung man hinh may
tinh:

Hoat dong

+ Hay dat man hinh & khu vyc khéng cé
anh sang trye tiép ctia mat, anh sang
ric c6 cweng d6 manh va cach xa
b4t ky ngudn nhiét nao khac. D&t man
hinh lau ngay trong maéi trwdng nay cé
thé khién cho man hinh bi bac mau va
héng.

«  Di chuyén moi db vat c6 thé roi vao
céac 16 théng gid ctia man hinh hodc
ngan can qua trinh lam mat thich hop
cla c4c thiét bj dién t&r bén trong man
hinh.

« Khéng bit kin cac 16 théng gio6 trén vé
man hinh.

«  Pam bao dat man hinh & gan noi cé
phich c&m va 6 cam dién.

« Néu tat man hinh bang cach rut cap
nguén hodc day dién DC, hay doi 6
giay trwde khi cdm cap ngudn hodc
day dién DC d& man hinh hoat déng
binh thwong.

« Hay ludn dung cap ngudn chuén duwoc
cép bai Philips. Néu thiéu cap ngudn,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (Vui ldong tham khao
muc Trung tdm thong tin tiéu dung
cham séc khach hang)

« Khéng dat man hinh & noi bi chan
dong hay va cham manh khi dang
hoat dong.

» Khdéng dap hoac lam roi man hinh khi
dang hoat dong hoéc khi di chuyén.

Bao duwdng

« D& man hinh khéng bj héng, khéng dé
nén qua manh lén mat man hinh LCD.
Khi di chuyén man hinh, hay ndm chét
khung man hinh d& nhéc Ién; khong
nh&c man hinh bang cach d&t ban tay
hodc ngén tay Ién mat man hinh LCD.

R0t phich cdm man hinh néu ban khéng
dinh sr dung né trong th&i gian dai.

« Rt phich cdm man hinh néu ban can
lau chtii man hinh bng mét miéng
vai hoi wét. Ban c6 thé lau man hinh
b&ng vai kho khi da ngat dién. Tuy
nhién, dwng bao gi& dung dung moi
htru co, chang han nhw con hoac cac
chét 16ng c6 ngudn gbc tir amoniac dé
lau man hinh.

« Dé tranh nguy co bi dién giat hoac
héng vinh vién bé man hinh, khéng
dat man hinh & noi ¢6 bui, mwa, nwéc
hodc & noi qua &m wot.

« Né&u man hinh bi wét, hay lau né bang
vai kho cang sém cang tét.

« Néu chét la hodc nwéc dinh vao man
hinh, hay ngét dién ngay va rat cap
ngudn. Sau d6 lau sach chét la hodc
nwéce rdi glri man hinh dén trung tam
bdo dudng.



+ Khéng cét gitr ho&c st dung man hinh
& noi cd ngudn nhiét, anh nang truc
tiép hoac qua lanh.

« D& duy tri hoat dong t&i wu cia man
hinh va st dung né trong th&i gian dai,
hay dung man hinh & noi ndm trong
gi&i han nhiét d6 va do 4m sau.

* Nhiét do: 0-40°C 32-95°F
+ D06 &m: 20-80% RH

+ LUU Y: Luén bat trinh bdo vé man
hinh chuyé&n dong khi ban khéng st
dung man hinh. Ludn bat &rng dung
lam m&i man hinh dinh ky, néu khoéng,
man hinh ctia ban sé hién thi nhirng
ndi dung tinh khong thay ddi. Hién thi
lién tuc cac anh tinh trong mét thoi
gian dai cé thé gay ra hién twong “anh
thtr nédng”, con dwgc goi la “anh ao”
hay “anh béong ma”, trén man hinh cla
ban.

“Anh th&r néng”, “Anh a0” hay “Anh
béng ma” la hién twong phé bién trong
cbéng nghé man hinh LCD. Trong hau
hét cac trwdng hop, hién twong “anh
thtr ndbng” hodc “anh 40” hay “adnh
béng ma” sé& dan dan bién mat sau
mot th&i gian man hinh bi ngét dién.

O canh bao

Céc hién twong “anh thir nong” hay “anh
40” hay “anh béng ma” sé& khong biét mét
va ban can mang man hinh di stra. Thiét
hai nhw trén khéng ndm trong chinh sach
bao hanh cda chung toi.

Dich vu

»  Chinhan vién dich vu chuyén mon
maoi dwoc mé vo boc man hinh.

«  Né&u can moi tai liéu hwéng dan dé
stra chira hodc tich hgp man hinh,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (vui long tham khdo
chwong “Trung tdm théng tin tiéu
dung”)

« D& biét thong tin v& viéc van chuyén,
vui Iong tham khao muc “Théng sb ky
thuat”.

« Khoéng dat man hinh trong xe hoi/cdp
xe dwéi &nh nang truc tiép.

& Ghi chu

Hay tham kh&o y kién cla k¥ thuat vién
dich vu néu man hinh khéng hoat déng
binh thuwdng hodc néu ban khéng chac
phai thwc hién quy trinh nao khi da lam
theo cac hwéng dan hoat déng néu trong
sb tay nay.

1.2 M6 ta biéu twong

Cac muc phy sau day mé ta cac quy woc
vé biéu twong dung trong tai liéu nay.

Ghi chu, Lwu y va Canh bao

Trong toan bd sb tay nay, cac doan chi®
c6 thé di kém biéu twong va dwoc in dam
ho&c in nghiéng. Cac doan nay bao gdm
cac ghi chd, lwu y hodc canh bao. Chung
dwoc st dung nhw sau:

& Ghicha

Biéu twong nay cho biét cac théng tin
quan trong va cac bi quyét gidp ban tan
dung tét hé théng may tinh.

O Luu y

Biéu twong nay cho biét cac théng tin gitp
ban biét cach tranh dwoc sw ¢ héng hoc
tiém &n ddi véi phan clrng hodc mat div
lieu.

© canh bao

Biéu twong nay cho biét sy tbn thwong
co thé tiém an va gitp ban biét cach tranh
dwoc sw cb do.

Mbt s6 canh bao co thé xuét hién & nhiéu
dinh dang va cé thé khéng di kém mot
biéu tweng. Trong nhitng trwéng hop nay,
céach thirc trinh bay cu thé clia canh bao
doé dwoc quy dinh bdi co quan chirc nang
lién quan.



1.3 Virt bé san pham va vat liéu
déng goi

Thiét bj dién & dién tr bj virt bo-WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may

not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/
sustainability/recycling.




2. Cai dat man hinh El Lipchandé ‘
1. Dé‘lt man hinh nam sap trén bé mét‘
mém min, c&n than dé tranh lam tray

2.1 Lap dat xwdc hodc hong man hinh.
2. Gén try dé git¥ vao man hinh cho dén
B Noi dung géi hang khi né khoéa vao thich hop.

%%art

PHILIPS

3. Gitr chan d& man hinh bang ca hai tay
va |ap chat chan dé vao tru dé.

VGA (tuy chon) DVI (tuy chon)



El Két néi véi PC

@ Dau vao ngudn dien AC

© Diu vao VGA

© Dau vao DVI-D (co6 sén cho cac mau
vira chon)

© Déau vao am thanh (c6 sén cho cac
mau vira chon)

© Khoa chdng trdm Kensington

Két néi véi PC

1. C&m chét cap ngudn vao mét sau cla
man hinh.

2. Tt may tinh va rat cap ngudn.

3. Cam cap tin hiéu man hinh vao 16 cdm
video & mat sau may tinh.

4. Cam cap nguon cta may tinh va cap
nguon clia man hinh vao 6 cdm dién
gan dé.

5. Bat may tinh va man hinh. Néu man
hinh hién thi hinh anh thi qua trinh cai
dat da hoan tat.

2.2 Str dung man hinh

El Mb ta mat trwéc cha san pham

Mau 190V3LA/190V3A:

(5]
AUTO/ W /A /o/; @fOK dl)
(7] (6] o 6 0 (1]
Mau 190V3L/190V3:
(5]
AUTO/ W /A /0/4\ @fOK (ll)
(7] (6] o 6 0 (1]
BAT va TAT ngudn man
I .
o O hinh.
Truy nhdp menu OSD.
© (/0K |Xac nhan diéu chinh menu
OSD.
© 4« |Trdvé mirc OSD trudec.
©® & |Chinh d6 sang.
© | A V¥ Chinh menu OSD.
1l |Chinh am lwgng loa.
e 2 2
[ |DPa6i dinh dang hién thi.
@ | AUTO | Tw déng chinh man hinh.




. Cai dat man hinh
E1 M6 ta menu Hién thi trén man hinh Menu OSD

Hién thi trén man hinh (OSD) Ia gi? Duéi day Ia tong quan vé co cau clia
Hién thi trén man hinh (OSD) la mét tinh ey Hien thi trén e ht'r?f" Bf.‘” i the
nang c6 & moi man hinh LCD ctia Philips. sw dung co cad nay fam thong fin tham
N6 cho phép ngudi dung didu chinh hoat khgo khi mt‘lon thwe hién cac diéu chinh
dong cia man hinh hogc chon cac chirc khac sau nay.

nang ctia man hinh tryc tiép thong qua

~ N 2 , % L2 N N Main menu Sub menu
mét ctra sO hwdng dan hién thj trén man
hinh. Mét giao dién hién thi trén man hinh
dé& str dung duoc thé hién nhu sau: - [ VGA
MAu 190V3LA/190V3A: bV

(available for selective models)

i VGA .
<= Input SeEE————
- DVI 0 Picture Format — Wide Screen, 4:3
B — Picture
3 et 5 Brightness — 0~100
|q Audio —_— Contrast — 0~100
. SmartContrast —— On, Off

Stand-Alone — On, Off
— Audio

Mute — On, Off

(available for selective models)

Color Temperature — 6500K, 9300K
— Color
sRGB
User Define Red: 0~100
Green: 0~100
Blue: 0~100
— Language — English . Espafiol, Frangais, Deutsch, Italiano,

Portugués, Pycckuin, AL, Turkge

— Horizontal — 0~100
— OSD Settings
— Vertical — 0~100
IIIIIHII‘;‘II 100 [ Transparency — Off, 1,2,3,4
1 50 L— OSD Time Out —— 5s, 10s, 20s, 30s, 60s
off
L— Setup — Auto
— H. Position — 0~100
— V. Position — 0~100
— Phase — 0~100
, > N .n - — Clock — 0~100
Hwéng dan co ban va don gian vé cac °°
nat dléu khlén — Resolution Notification — On, Off
Trong menu OSD minh hoa & trén, ban ¢ [ Reser — Yes,No
thé nhan ¥ A cac nat & g& mat trwdc cla L Information

man hinh dé di chuyén con trd va nhan nat
OK dé xac nhan Iwa chon hodc thay déi.



El Théng bao vé dé phan giai 2.3 Thao dé va chan dé
Man hinh nay dwoc thiét k& dé hoat déng

t6i wu véi do phan giai gbc 1a 1440 x 900 H Thao chan gé

@ 60 Hz. Khi dwgc chinh sang d6 phan Trwéc khi bat dau thao chan dé man

gidi khac, man hinh sé& hién thi mot théng hinh, hay thwc hién theo cac hwéng dan
bao: Dung 1440 x 900 @ 60 Hz dé dat két bén dwéi dé tranh moi thiét hai hay chan
qua tét nhét. thwong cé thé xay ra.

Ban c6 thé tt thdng bao hién thi d6 phan 1. Bat man hinh nam sap trén bé mat
giai gbc tr muc Setup (Cai dat) trong min, can than de tranh lam tray xwoc
menu OSD (Hién thj trén man hinh). hoac héng man hinh.

El Tinh ning vat ly
Nghiéng

2. An vao cac kep khéa dé thao chan dé
ra khai tru dé.




B Thao dé & Note

1. Ban co thé sk dung tua vit dau det gé& This monitor accepts a 100mm x 100mm VESA-
4n vao hai khép nha trén np ban 1& Compliant mounting interface.
va cay nhe nap ban Ié dé thao no ra.

100mm

100mm

2. Théao 4 dinh vit rdi thao chan dé ra
khoi man hinh.




3. Toi wu héa hinh anh

3.1 SmartContrast

EH po1a gi?

Cbng nghé doc dao vén linh hoat phan
tich noi dung hién thi va tw déng téi wu
héa ty & twong phan ctia man hinh LCD
dé mang lai do ré nét va trai nghiém xem
tdi wu, tdng mrc dén nén dé hién thi
nhi*ng hinh anh sang ré hon, sic nét hon
va sbng dong hon hay gidam mdc dén nén
d& hién thi rd hinh anh trén phong nén téi.
E sao t6i phai can n6?

Ban muén hién thj ndi dung rd nét ciing
cadm giac thoai mai nhat khi xem moi loai
n6i dung. SmartContrast sé linh hoat chinh
do twong phan va mirc dén nén dé hién
thi nhirtng hinh anh choi game hay video
cwe rd, sbng déng va sac nét hay hién thj
ndi dung chiv rd rang dé doc cho céac rng
dung van phong. Bing cach giam viéc tiéu
thu dién cGa man hinh, ban sé tiét kiém
dwoc chi phi ndng lwong va kéo dai tudi
tho cho man hinh cta ban.

El cach hoat dong?

Khi ban bat ché d& SmartContrast, n6 sé
phan tich ndi dung dang hién thj trong
thwe t& dé chinh mau sac va mat do den
nén. Chirc nang nay sé linh hoat téng
do twong phan dé mang lai cho ban trai
nghiém giai tri tuyét v&i khi xem video
hoac choi game.

3.2 Philips SmartControl Lite

Phan mém SmartControl Lite m&i cla
Phillips cho phép ban diéu khién man hinh
qua giao dién dd hoa 4o tién dung. Cac
diéu chinh phtrc tap la nhitng gi thudc

vé qué khir vi phan mém than thién voi
nguoi dung nay sé hwéng dan ban qua
viéc tuy chinh d¢ phéan gidi, hiéu chinh
mau, diéu chinh déng hd/géc pha, diéu
chinh diém trang RGB (Dé-Luc-Lam), v.v...

Trang bi cdng nghé mai nhat vé thuat toan

I6i x& ly va phan (rng nhanh, phan mém

chay béng anh déng bt mat thwong thich

vé&i Windows 7 nay sé&n sang nang cao trai

nghiém cuta ban v&i man hinh Philips!

B cai aat

«  Thuwc hién theo chi dan va hoan tat quy
trinh cai dat.

+ Ban c6 thé kh&i ddng phdn mém sau
khi hoan tat cai dat.

«  Néu mubdn kh&i ddng sau, ban c6 thé
click phim tat phdn mém trén man hinh
nén hodc thanh céng cu may tinh.

PHILIPS e g ez

Monitor driver and software installation

Wizard (Thuat si) kh&i dong lan dau

+ Lan dau khi cai d&t phan mém
SmartControl Lite, n6 sé ty dong vao
Wizard (Thuat si) khéi déng lan dau.

» Thuat si nay s& hwdng dan ban théng
qua viéc diéu chinh tirng budc vé hiéu
suét man hinh.

+ Sau nay ban ciing c6 thé vao menu
Plug-in (B4 sung) dé bat thuat sT.

« Ban c¢6 thé chinh cac tuy chon khac
qua giao dién Standard (Chuan) ma
khéng can thuat si.



. T6i wu héa hinh anh
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Menu Adjust (Diéu chinh) cho phép ‘
ban chinh Brightness (D6 sang),
Contrast (D6 twong phan), Focus
(Trong tam), Position (Vi tri) va
Resolution (D6 phan giai).

Ban c6 thé 1am theo chi dan va thuc
hién diéu chinh.

Lénh Cancel (HUy) sé héi nguwdi dung
xem ho c6 mudn hay tién trinh cai dat
hay khéng.
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3. T6i wu héa hinh anh

[ Tewr—

SmartControl Lite

ggaA®

Menu Color (Mau):

*  Menu Color (Mau) cho phép ban chinh
mau RGB (Bd-Luc-Lam), Black Level

2-prien 22383 (coar1300803) ()%

PHILIPS

Resolution

(Do t6i), White Point (Biém tréng),
Color Calibration (Hiéu chinh mau).

« Ban c6 thé 1am theo chi dan va thuc

hién diéu chinh.

Tham thao bang bén dwéi dé hinh

dung co ban v& muc menu phu trén
théng tin nhap cua ban.

mau sic):
[

SmartControl Lite
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. T6i wu héa hinh anh

1.

“Show Me” (Cho t6i xem) sé bat
hwéng dan hiéu chinh mau.

Start (Bat du) - bat dau quy trinh
canh chinh mau qua 6 budc.

Quick View (Xem nhanh) tai cac hinh
anh trwdc/sau.

Tré vé giao dién chinh Color (Mau),
click nut Cancel (Huy).

Enable color calibration (Bat hiéu
chinh mau) - theo mac dinh la dwoc
bat. Néu khdéng chon muc nay, ban
khéng dwoc phép hiéu chinh mau va
tét cac nat khéi dong va xem nhanh.
Phai c6 théng tin bang sang ché trén
man hinh hiéu chinh.

Man hinh hiéu chinh mau dau tién:

Nt Previous (Trwéc) sé tat cho dén
khi man hinh mau th( hai bat 1én.
Next (K& tiép) s& chuyén vao muyc tiéu
tiep theo (6 muc tiéu).

Cuéi cling, vao giao dién File>Presets
(File>Cai san).

Nut Cancel (Hly) sé dong giao dién
nguwdi dung (Ul) va tré vé trang bd
sung.

12

Options>Preferences (Tuy chon>Uu
tién) - Sé chi hoat dong khi chon
Preferences (Uu tién) tr menu Options
(Tuy chon) sb xudng. Trén man hinh
khéng héd tro twong thich véi chudn DDC/
Cl, chi c6 s8n cac thé Help (Tro gitp) va
Options (Tuy chon).

[ o 3P 2238 (C0TI8800001) 2%

SmartControl Lite PHILIPS

« Hién thi cac cai dat wu tién hién hanh.

« O viva chon sé& bat tinh nang nay. O
chon la nat bat/tat.

» Enable Context Menu (Menu bat thudc
tinh) trén man hinh nén PC sé& dwoc
chon la (Bat) theo mac dinh. Enable
Context Menu (Menu bat thudc tinh)
hién thi cac lwa chon SmartControl
Lite cho Select Preset (Chon cai sén)
va Tune Display (Chinh man hinh)
trong menu thudc tinh khi click phai
vao man hinh nén. Disabled (Da tét)
sé x6a SmartControl Lite khdi menu
thudc tinh click phai.

+ Biéu twong Enable Task Tray (Bat
khay tac vu) dwoc chon la (Bat) theo
mac dinh. Menu bat thudc tinh hién thi
menu khay tac vu cho SmartControl
Lite. Click phai vao biéu twong khay
tac vu sé hién thi cac tuy chon menu
cho Help (Tro giup), Technical Support
(H6 tro ky thuat), Check for Update
(Kiém tra cap nhat), About (V&) va Exit
(Thoat). Khi da t&t Enable task tray



menu (Menu bat khay tac vu), biéu
twong khay tac vu sé chi hién thj EXIT
(THOAT).

e Theo mac dinh Run at Startup (Chay
khi khé&i dong) sé dwoc chon la (BAT).
Khi da tat, SmartControl Lite sé khéng
bat khi kh&i ddng hodc nam trong
khay tac vu. Cach duy nhét dé bat
SmartControl Lite la tlr phim t&t trén
man hinh nén hoéc tir file chwong
trinh. Bat ky bo cai dat sdn nao dé
chay khi kh&i ddng sé hoat déng
khéng tai khi 6 nay khong dwgc chon
(Pa tat).

« Enable transparency mode (Bat ché
dé trong subt) (Windows 7, Vista, XP).
Mac dinh la 0% Mo.

Options>Input (Tuy chon>Nhap) - Sé

chi hoat déng khi chon Input (Nhap) tt

menu Options (TUy chon) sé xudng. Trén
man hinh khéng hé trg twong thich voi
chuén DDC/CI, chi c6 sén cac thé Help

(Tro gitp) va Options (Tuy chon). TAt ca

cac thé SmartControl Lite khac déu khéng

co sén.
W St Pl 1738 13 fx

PHILIPS

= o
-

« Hién thi giao dién hu’c'rqg dan Source
(Nguon) va cai dat nguon nhap théng
tin hién hanh.

e Trén cac man hinh nhap riéng, giao
dién nay sé khong hién thi.
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Options>Audio (Tuy chon>Am thanh)
- Sé chi hoat dong khi chon Audio (Arp
tha'nh) tr menu Options (Tuy chon) s6
xuong.
Trén man hinh khéng hé tro twong thich
v&i chudn DDC/CI, chi co sén cac thé
Help (Tro giup) va Options (Tuy chon).
P snartone Lo 18 x
SmartControl Lite PHILIPS

Audia

=

L 2
e

‘A

&

3
=

Help>User Manual (Tro’ giip>S6 tay stv
dung) - Sé chi hoat dong khi chon User
Manual (S tay st dung) t menu Help
(Tro gitp) sb xubng. Trén man hinh khéng
hé tro twong thich véi chuan DDC/CI, chi
c6 sén cac thé Help (Tro giup) va Options

(Tuy chon).
SmartControl Lite PHILIPS

User Mana! 1

-1 L T TF



Help>Version (Tro’ giup>Phién ban) - S&
chi hoat dong khi chon Version (Phién
ban) t& menu Help (Tro gilp) s xudng.
Trén man hinh khéng hé tro' twong thich
v6i chudn DDC/CI, chi c6 sén cac thé
Help (Tro giup) va Options (Tuy chon).
SmartControl Lite PHILIPS

User Manua 1

it lele e ?5

Menu nhay cam vé&i thudc tinh

Theo mac dinh, Context Sensitive Menu
(Chinh theo thuéc tinh) s& dwoc Bat. Néu
da chon Enable Context Menu (Bat thudc
tinh) trong giao dién Options>Preferences
(Tuy chon>Uu tién) thi menu nay sé hién
thi.

D SmartControl
Helect Preset L3
Tune Display

Menu Thudc tinh c6 ba muc nhép:

« SmartControl Lite - khi da chon, About
Screen (V& man hinh) s& hién thi.

» Select Preset (Chon cai dat sén) -
Cung cAp menu cac muc cai san da
Iwu theo trinh tw dé st dung ngay.
DAu kiém sé& hién thi muc cai san hién
da chon. Muc Factory Preset (Cai sén
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gbc) ciing co thé dwoc chon tir menu
sO xudng.

* Tune Display (Chinh man minh) - M&
bang diéu khién SmartControl Lite.

+  Smartimage Lite - Kiém tra cac cai dat
hién hanh, Standard (Chuén), Internet,
Game.

Da bat menu khay tac vu

Ban c6 thé hién thi menu khay tac vu
bang cach click phai vao biéu twong
SmartControl Lite ttr khay tac vu. Click trai
sé bat rng dung.

Help

Technical Support
Check for Update
About

Exik

Khay tac vu c6 nam muc nhap:

¢ Help (Tro gidp) - Truy cap file User
Manual (SO tay si* dung): M¢ file User
Manual (S6 tay s dung) qua clra sb
trinh duyét mac dinh.

+  Technical Support (H6 tro kj thuat) -
hién thj trang hd tro' ky thuat.

«  Check for Update (Kiém tra cap nhat)
- dan nguwoi dung dén N&n (ng dung
PDI va kiém tra phién ban clia nguoi
diing so v&i phién ban co sén méi
nhét.

* About (V&) - Hién thi thong tin tham
khdo chi tiét: phién ban san pham,
thong tin vé phién ban va tén san
pham.

» Exit (Thoat) - Bong SmartControl Lite.

pé chay lai SmartControl Lite, hdy chon
SmartControl Lite ttr menu Program
(Chwong trinh), click déi biéu twong PC
trén man hinh nén hoac khai dong lai hé
théng.



. T6i wu héa hinh anh

PHILIPS
Smart!‘ trol

areion 320
dhune-standard-R2007-H -04-1151-23
Copyright 1963-2007 Portred Dueplays, .
Paipns Penaing

D4 tat menu khay tac vu

Khi da tat Khay tac vu trong thu muc

wu tién, chi con cé san lwa chon EXIT
(THOAT). Bé x6a hoan toan SmartControl
Lite khéi khay tac vu, hay tét Run at
Startup (Chay khi kh&i dong) trong
Options>Preferences (Tuy chon>Uu tién).
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4. Cac thoéng sé ky thuat

Loai mat man hinh TFT-LCD

Deén nén LED/CCFL

C& man hinh Rong 19 inch (48,3cm)
Hé sé co 16:10

Do pixel 0,284 x 0,284 mm

Do sang 250 cd/m?

Do twong phan théng minh 10,000,000:1

Do twong phan (chuan) 1000:1

Thoi gian dap (ng (chuén) 5ms

1440 x 900 @ 60Hz

Gobc xem

170° (H) / 160° (V) @ C/R > 10

Mau man hinh

16,7 triéu mau

Pau vao tin hiéu

Tbc d6 phat doc 56Hz - 76Hz
Tan s6 ngang 30kHz - 83kHz
SRGB (Pd-Luc-Lam chudn) | CO

DVI (KTS), VGA (Analog)

Tin hiéu vao

Tién ich cho ngu®i dung

Ddng bo riéng, Bdng bd véi tin hiéu xanh luc

190V3LA/190V3A:

AuTO/vY (/A 0/ 4 /0K 0)
190V3L/190V3:

AUTO/VY  D/A 0/ 4 /0K 0)

Ngén ng OSD (Hién thj trén
man hinh)

Tiéng Anh, Tiéng Phap, Tiéng Dlrc, Tiéng Tay Ban Nha,
Tiéng Y, Tiéng Nga, Tiéng Hoa Gian thé, Tiéng Bd Dao
Nha, Tiéng Thé Nhi Ky

Tién ich khac

Khbéa Kensington

Tuong thich voi chuan Plug
& Play (Cam vao la phat)

DDCI/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

Nghiéng

-5/+20

190V3LA:

Ché do bat

17,7W (chuén), 20,5W (t6i da)

Tiét kiem nang lwong
(Phwong phap thtr nghiém
EnergyStar 5.0)

Dién 4p dau vao | Dién ap dau vao | Dién ap dau vao
AC v&i cong AC v&i cong AC v&i cong
suat 100VAC suat 115VAC suat 230VAC
+/-5VAC, 50Hz +/-5VAC, 60Hz +/-5VAC, 50Hz
+/- 3Hz +/- 3Hz +/- 3Hz
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Hoat dong théng thwong

2 13,40W 13,30W 13,50W
(chuan)
Ché d6 ngu (cho) 0,5W 0,5W 0,5W
Tat 0,5W 0,5W 0,5W
Dién ap dau vao | Dién ap dau vao | Dién ap dau vao
AC’ v&i cong AQ v&i cong AC’ v&i cong
Tan nhiét* suét 100VAC suét 115VAC suét 230VAC
+/-5VAC, 50Hz | +/-5VAC, 60Hz | +/-5VAC, 50Hz
+/- 3Hz +/- 3Hz +/- 3Hz
Hoat dong théng thwong 45,73 BTU/giov 45,39 BTU/gir 46,08 BTU/gioy
Ché d6 ngu (chd) 1,706 BTU/gior 1,706 BTU/gi®» 1,706 BTU/gio
Tat 1,706 BTU/gio» 1,706 BTU/gio» 1,706 BTU/gior
Dén bao LED nguén Ché d6 bat: Ché d6 Trang, Cha/Ngu: Tréng (nhap nhay)
Bo nguodn Thir néng, 100-240VAC, 50-60Hz
190V3A:
Ché do bat 20,33W (chudn), 25,31W (tdi da)

Tiét kiem n&ng lvong
(Phwong phap thtr nghiém

Dién ap dau vao
AC voi cong
suat 100VAC

Dién ap dau vao
AC v&i cong
suat 115VAC

Dién ap dau vao
AC véi cong
suat 230VAC

Ché do bat

EnergyStar 5.0) +/-5VAC, 50Hz +/-5VAC, 60Hz +/-5VAC, 50Hz
+/- 3Hz +/- 3Hz +/- 3Hz

GRS Glomg U] HILEE | g ey 18,04W 17,92W

(chuan)

Ché d6 ngti (cho) 0,5W 0,5W 0,5W

Tét 0,5W 0,5W 0,5W
Dién ap dau vao | Dién ap dau vao | Dién ap dau vao
AC’ v&i cong AQ v&i cong AC’ v&i cong

Tan nhiét* suat 100VAC suat 115VAC suat 230VAC
+/-5VAC, 50Hz +/-5VAC, 60Hz +/-5VAC, 50Hz
+/- 3Hz +/- 3Hz +/- 3Hz

Hoat dong thong thuwong 62,05 BTU/gio 61,57 BTU/gio 61,16 BTU/gio

Ché d6 ngu (chd) 1,706 BTU/gio 1,706 BTU/gio 1,706 BTU/gio

Tat 1,706 BTU/gio 1,706 BTU/gio 1,706 BTU/gio

Dén bao LED ngudn Ché do bat: Ché do Trang, Chd/Ngu: Trang (nhap nhay)

Bo ngudn Thir néng, 100-240VAC, 50-60Hz

190V3L:

17,1W (chudn), 19,1W (t6i da)

Tiét kiem n&ng lvong
(Phwong phap thlr nghiém
EnergyStar 5.0)

Dién ap dau vao
AC v&i céng
suét 100VAC
+/-5VAC, 50Hz
+/- 3Hz

Dién ap dau vao
AC v&i cong
suat 115VAC
+/-5VAC, 60Hz
+/- 3Hz

Dién ap dau vao
AC v&i céng
suét 230VAC
+/-5VAC, 50Hz
+/- 3Hz
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Hoat dong théng thwong

5 14,90W 14,80W 15,10W

(chuan)

Ché d6 ngu (cho) 0,5W 0,5W 0,5W

Tat 0,5W 0,5W 0,5W
Dién ap dau vao | Dién ap dau vao | Dién ap dau vao
AC’ v&i cong AQ v&i cong AC’ v&i cong

Tan nhiét* suét 100VAC suét 115VAC suét 230VAC
+/-5VAC, 50Hz | +/-5VAC, 60Hz | +/-5VAC, 50Hz
+/- 3Hz +/- 3Hz +/- 3Hz

Hoat dong théng thwong 50,85 BTU/gi®y 50,51 BTU/gi® 51,54 BTU/giov

Ché d6 ngu (chd) 1,706 BTU/gior 1,706 BTU/gi®r 1,706 BTU/gior

Tat 1,706 BTU/gio» 1,706 BTU/gio» 1,706 BTU/gio»

Dén bao LED nguén Ché d6 bat: Ché d6 Tréng, Cha/Ngu: Tréng (nhap nhay)

B6 nguodn Thir néng, 100-240VAC, 50-60Hz

190V3:
Ché do bat 19,7W (chuan), 21,8W (t6i da)

, Dién ap dau vao | Pién ap dau vao | Dién ap dau vao
Tiet kiém nang lwong AC v&i cong AC v&i cong AC v&i cong
(Phwong phap thir nghiém suat 100VAC suat 115VAC suat 230VAC
EnergyStar 5.0) +/-5VAC, 50Hz +/-5VAC, 60Hz +/-5VAC, 50Hz

+/- 3Hz +/- 3Hz +/- 3Hz
GRS Glomg U] HILETE | e v 19,20W 19,00W
(chuan)
Ché d6 ngli (cho) 0,5W 0,5W 0,5W
Tét 0,5W 0,5W 0,5W
Dién ap dau vao | Dién ap dau vao | Dién ap dau vao
AC’ v&i cong AQ v&i cong AC’ v&i cong
Tan nhiét* suat 100VAC suat 115VAC suat 230VAC
+/-5VAC, 50Hz +/-5VAC, 60Hz +/-5VAC, 50Hz
+/- 3Hz +/- 3Hz +/- 3Hz
Hoat dong thong thuwong 65,87 BTU/gio 65,53 BTU/gio 64,85 BTU/gio
Ché d6 ngu (chd) 1,706 BTU/gio 1,706 BTU/gio 1,706 BTU/gio
Tat 1,706 BTU/gio 1,706 BTU/gio 1,706 BTU/gio
DPén bao LED ngudn Ché do bat: Ché do Trang, Chd/Ngu: Trang (nhap nhay)
Bo ngudn Thir néng, 100-240VAC, 50-60Hz

=enipRamKE TS0 g I o D2 Ol
(Rong x cao x day)

San pham khong kém theo | g5, 349 4 54 mm
dé gilr (Rdng x cao x day)

San pham kém theo dé gitv | 2,62kg(LED)/3,57kg(CCFL)
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San pham khong kém theo
dé gitv

2,33kg(LED)/3,28kg(CCFL)

San pham déng goi

3,73kg(LED)/4,67kg(CCFL)

Pham vi nhiét d6 (hoat dong)

0°C-40°C

Pham vi nhiét d (Khong
hoat dong)

-20°C-60°C

Do am tuong déi

20% - 80%

Po cao

Hoat dong: + 365.760,00cm (3.658m)
Khéng hoat dong: + 1.219.200,00cm (12.192m)

MTBF (Thoi lvong trung
binh gilra cac sy co)

30.000 gi&(LED)/50.000 gi&(CCFL)

Chi thi ROHS (Gi¢i han cac

Phé chuéan theo quy dinh

Mau

chét gay hai) €9
EPEAT Bac (www.epeat.net)
Thung dung Co6 thé tai ché 100%

CE Mark, FCC Class B, GOST, SEMKO, TCO Certified
(Only for selective models), UL/cUL, BSMI,
1IS09241-307,C-Tick

Pen

L&p son ngoai

Bong lang/Hoa van

& Ghichu

1. Vang hay bac EPEAT chi ¢6 hiéu lwc tai noi ma Philips da dang ky san pham. Hay truy
cap www.epeat.net dé biét nh trang déng kw tai quéc gia cta ban.

2. D liéu nay chiu sw thay ddi ma khéng can théng bao trwée. Truy cap www.philips.com/
support dé tai vé& phién ban td roi méi nhét.
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4.1 Ché do dé phan giai & cai
dit san

El D6 phan giai téi da
1440 x 900 @ 60 Hz (d4u vao analog)
1440 x 900 @ 60 Hz (d4u vao KTS)

E1 Do phan giai khuyén ding
1440 x 900 @ 60 Hz (d4u vao KTS)

31,47 720 x 400 70,09
31,47 640 x 480 59,94
35,00 640 x 480 66,67
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
55,94 1440 x 900 59,89
70,64 1440 x 900 74,98

& Ghicha

Lwu y réng man hinh cla ban hoat déng
tbt nhat & do phan giai gbc 1440 x 900 @
60Hz. D& c6 chét lwong hién thi tbt nhat,
hay dung d6 phan giai khuyén nghi nay.
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5. Quan ly ngudn dién

Néu ban da cai dat card man hinh hay
phan mém twong thich chudn VESA DPM
vao PC, man hinh c6 thé tw déng giam
tiéu thu dién khi khéng str dung. Néu phat
hién nhap tlr ban phim, chudt hay thiét bi
nhap khac, man hinh sé “hoat dong” tw
déng. Bang sau day sé hién thi mc tiéu
thu dién va cach truyén tin hiéu cla tinh
nang tiét kiem dién tw dong nay:

190V3LA:

Ché do - Pdng bd| Bdng | Ngudn dién | Mau dén
VESA ngang | b6 doc str dung LED
. ) X 17,7W e
Hoat dong| BAT Co Co (chuén) Trang
£ 1 Tréng

an‘:c‘r’]%) TAT | Khong | Khéng (Zr?u%‘:]v) (Nhap

9 nhay)

T&t | TAT| - - =0ty TAT
(chuan)

190V3A:

Ché do Video Dbdng bd| Bbdng | Nguén dién | Mau dén
VESA ngang | b6 doc st dung LED
. 2 . . 20,33W <
Hoat déng| BAT Co Co (chuin) Trang
P Tréng
Chedo | 171 | Khong | kneng | =23 | (Nnp
ngu (cho) (chuan) nhéy)
Tét | TAT | - - o TAT
(chuan)
190V3L:
Ché do Video Pdng bd| Bbdng | Ngudn dién | Mau dén
VESA ngang | bo doc str dung LED
Hoat déng| BAT Co Co (l;[}g:) Tréng
£ Tréng
Chedo | 14T | khong | khong | <95 | (Nhp
ngu (cho) (chuan) nhéy)
T&t | TAT| - - b TAT
(chuan)

190V3:

Ché do Video Pdng bd| Bdng | Ngudn dién | Mau dén
VESA ngang | bo doc str dung LED
A . . 19,7W <

Hoat dong| BAT Co Co (chu&n) Trang
i Tréng
ngcg‘?cf‘%) TAT | Khong | Khéng :c:usé‘::’) (Nhap
nhay)

Tat | TAT| - - <O0SW | raT

(chuan)

Cai dat sau day dwoc dung dé& do mirc

tiéu thu dién trén man hinh.

« Do phan giai gbc: 1440 x 900

* Do twong phan: 50%

* DO sang: 250 nit

« Nhiét dd mau: 6500k véi kiéu mau
trdng day du

& Ghicha

D@ liéu nay chiu sw thay dbi ma khong

can thdng bao trudrc.



6. Théng tin quy dinh

Lead-free Product

Lead free display promotes
environmentally sound recovery

B and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!
This display is designed for both you and the

planet

carries the TCO Certified label.
This ensures that your display is

designed, manufactured and tested according to

some of the strictest quality and environmental

requirements in the world. This makes for a high

performance product, designed with the user

in focus that also minimizes the impact on the

climate and our natural environment.

The display you have just purchased

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the
TCO Certified for displays:

*  Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.
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*  Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of
the TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

* Very low energy consumption both in on-
and standby mode minimize climate impact.

e Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

*  Both product and product packaging is
prepared for recycling.

*  The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is
now requested by users and [T-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document, Ver. 2.1

I[u Technology for you and the planet
CERTIFIED

(Only for selective models)



EPEAT

(www.epeat.net)
S The EPEAT (Electronic
& Product Environmental
X

Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through

an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

» EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

* EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

»  EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

* 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on ISO9000
level.

The product also comply with the following

standards

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

* GS EK1-2000:2009 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

* MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

* TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

h As an ENERGY STAR® Partner, we
have determined that this product

rerfi meets the ENERGY STAR?

guidelines for energy efficiency.

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission
(FCC) Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la
Communication (FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
l'article 15 Des regles de la FCC. Ces
limites sont congues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



6. Thong tin quy din

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

*  Augmenter la distance entre 'équipement
et le récepteur.

* Brancher I'€quipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic
Only)

This device belongs to catagory B devices as described in EM 55022, unless it is spacifi-
cally stated that it ia a Class A devics on the spscification labsl. The following applies to
devices in Class A of EN 55022 (radius of protection up to 30 meters). The usar of the
davics i ohiiged to take all stapa necassary to temove sources of intarfersnce io tels-
communication or ather devicss.

Fokud neni na typovém Stitku poSitade uvedeno, 28 spadd do do tfidy A podie EN 55022,
spadd automaticky do ffidy B podle EN 55022, Pro zafizenl zafazend do tidy A (chranné
pésma 30m) podie EN E5022 plati ndsleduicl Dojde-li k rulien! telekomunikadnich nebo
Jjch zafizani je utivatel povinnen provést takovd opatignl, aby nseni odstranil,

Polish Center for Testing and
Certification Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/T-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji

Uzadetic powinno byé zasitane # priagds 2 preytaceanyen obwoden ochronym (znisedo 2
Katkiem). Wapdlpracugace 2 sobg urzadzesia (Komputer, monstor, drukarka) powiniy byé zsilose
2 1epo samego dridla.

Instalacja elektrycma pomiesscrenia powinm mwiemé w przewoise Ezowym rezeraaws ochrang
precel wazciami, w pestaci berpiecentki o wirtodel mamionawe me wicksze] iz 184 (amperiw).
W celu calkowitego wylacamia ursdrenia i sleci zasilania, naleiy wylat wivezkg kabla
aasilancege 2 iinzdks, Ldre powinno 2 Jowad sus ' pobliz uezadToenia § byé o dostipie.
Faak beaplocarharwa "B” potwiordzs 2podendd urzsdzenis » wymaganianl bezplecasisiug
ueytkowania zawartymi w PN-S3T-42107 § PN-BAE46251

Pozostale instrukcje begpieczensiwa

Nie mley uzywad wiyceek sdapterowych Tub usuwaé kotka abwodu ochrannego 2 wiyeeki.,
el komsoczne jest utyese peacdiutacza to naledy uyé proediuzaces 3-sylowega 2
I )

¢ sii. aby nie nie lezato na ksblach systeru komputerowego, araz aby kable nie
sdzse midna byloby na nhe nadeptywad lub porykad slg o wie.

* Nie ey ol plymi s systoms Kooy

puterwy pawiisien Fnajdowad sig 2 dala od gracaikbo i nidel lepl. Porssdra
kecrwai atwordw wentylacyjych. Nakeiy anikat kadeenia lainych paperiow pod
karmpuler oriz umieszezanss karmpatera v cinsmym migjse ber mailiweic cyrkulacyi powi-
etz wokl nisgo




North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA,

BSMI Notice (Taiwan Only)
RAZHERERIEE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schdden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerdtes befindet sich

ein Aufkleber; der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
llla 5 Abs. 4 der Rontgenverordnung erfilit sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf|
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLURB LEICHT
ZUGANGLICH SIND.



6. Thong tin quy din

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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anh con cé mau sac cuing hién thi nhu mot

7. Dich vu cham séc diém anh den don I&. Nhing két hop diém

khéCh héng Vé béO én’h con sang va toi khac hién thj nhw cac
. diém anh don I1é tr nhirtng mau khac.

hanh Cac kiéu 16i diém anh

7.1 Chinh sach 16i didm anh Céc 16i diém &nh va diém &nh con hién thi

! . . 2 N . trén man hinh theo nhirng cach khac nhau.

man hinh phang cua Philips C6 hai kidu I8 didm anh va nhidu I6i diém

Philips cb gang cung cap cac san phdm anh con trong méi kiéu 16i.

chét lwgng cao nhét. Ching t6i ap dung
mot s quy trinh san xuat tién tién nhat
trong Iinh vuc va thwe hién quy trinh kiém
tra chat lwong nghiém ngat. Tuy nhién, cac «
I6i diém &nh hay diém anh con trén man hiy b’at Ngh'a; la “QP'Fha'E“ sar]g Ia‘ mét .
hinh TFT dung trong cac man hinh phéng d|gm qnh con von nol Iep trern).ma‘n h't‘h I,(hl
dbi khi khong thé tranh khéi. Khang nha man hinh hien thi kieu hinh 16i mo. C6 cac
san xuét nao co thé dam bao rang moi man ki€u 10i cham sang.

hinh s& khong co cac 16i diém &nh, nhung
Philips dam bao rang bat ky man hinh nao
c6 mdt sb 16i khong thé chap nhan sé duoc
slra chi*a hodc thay méi dwa vao chinh
sach bao hanh. Thong bao nay giai thich
nhirng kiéu I6i diém anh khac nhau va dinh
nghta cac mirc 16 cé thé chap nhan cho
m6i kiéu I6i. D& hudng dich vu stva chiva
hay thay thé theo chinh sach bao hanh, s6 . | .
lwong 16i diém anh trén man hinh TFT phai MGt dieém anh con sang do, luc hay lam.
vurot qua cac mirc chap nhan nay. Vi du,
khéng qua 0,0004% diém anh con trén man
hinh c6 thé bj 16i. Ngoai ra, Philips tham
con dat ra cac tiéu chuén chét lwgng cao
hon cho mét s6 kidu hay két hcrp 16i diém

anh vén d& nhin thay hon cac kiéu 16 khac. (¢
Chinh sach nay cé hiéu lyc trén toan cau.

Cac 16i cham sang
Céc 16i chdm sang hién thi duoi dang cac
diém anh hay diém &nh con vén luén sang

diém  diém  diém
anh phu anh phu anh phu

Hai didm anh con sang gan nhau:

- Dé+Lam=Tim
G RGB - Do+ Luc=Vang
didm - Luc + Lam = Luc lam (Lam nhat)
anh

DPiém anh va diém anh con
Diém anh hay phan t& anh gém ba diém

anh con trong cac mau chinh dé, luc va
lam. Nhiéu diém &nh ciing tao thanh hinh
anh. Khi moi diém &nh con clia mot diém
anh sang Ién, ba diém anh con cé mau sac
cting hién thi nhw mot diém anh trang don
1&. Khi moi diém anh con tdi mo, ba diém
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Ba diém anh con sang gan nhau (mét diém
anh trng).

& Ghi chu

Chém sang dé hay lam phéi sang hon
50% so v&i cac chdm xung quanh trong
khi chdm sang luc sang hon 30% so Vo
cac chdm xung quanh.

Cac 16i cham den

Cac 16i chdm den hién thj dwéi dang cac
diém anh hay diém anh con vén ludn téi
m& hay “tat”. Nghia 1a méi cham tbi mo
Ia mot diém anh con vén ndi lén trén man
hinh khi man hinh hién thj kiéu hinh sang.
C6 céac kiéu 16i chdm den.

Do gan cua cac 16i diém anh

Vi céc 16i diém anh va diém &nh con cla
cuing kiéu 16 vén gan véi mot kiéu 16i khac
c6 thé dé nhin thdy hon, Philips ciing néu
ré cac dung sai vé d6 gan cda 16i diém anh

Dung sai 16i diém anh

D& huwéng dich vu stra chiva hay thay

thé do cac 16i diém anh trong thoi han

bdo hanh, man hinh TFT trong man hinh
phéng Philips phai c6 cac 16i diém anh hay
didm &nh con vwot qué nhivng dung sai
néu trong cac bang sau.

A A ; A
1 diém anh con sang 3
2 diém anh con sang gan nhau 1
3 diém anh con sang gan nhau (mét diém anh trang) 0
Khoang cach gitra hai I6i chdm sang* >15mm
Téng s6 16i cham sang clia moi kiéu 16i 3

0 AM P AP A
1 diém anh con t&i mo 5 hoac it hon
2 diém anh con t6i m& gan nhau 2 hoéc it hon
3 diém anh con t6i m& gan nhau 0
Khoang cach gitva hai I6i chdm den* >15mm
Tbng sb 16i cham den ctia moi kiéu I5i 5 hodc it hon

TONG SO LOI CHAM

MUC CHAP NHAN

Tbng s 16i cham sang hay den ctia moi kiéu I6i

5 hoac it hon

& Ghi chi

1. 1 hay 2 16i diém &nh con gan nhau = 1 16i chdm
2. Man hinh nay tuan thd chuan 1S09241-307. (1IS09241-307: Yéu cau, phan tich vé hiéu
nang va cac phwong phap kiém tra tuan thd cho man hinh dién tt)



7.2 Cham séc khach hang & Ché dé bao hanh

D& c6 thdng tin chi tiét vé chinh sach bdo hanh va yéu cau hd tro thém dwoc ap dung cho
khu vire clia ban, vui long truy cap website www.philips.com/support. Bgn cling c6 thé lién
hé v&i Trung tdm cham soc khach hang dia phwong cda Philips theo sb dién thoai dwdi
day.

Théng tin lién lac cho khu vire TAY AU:

Qubc gia ASC (Trung tam  S6 cham séc khach

dich vu tly quyén) hang

Germany Siemens 1&S +49 01803 386 853 €0.09
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0.09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0.08
Netherlands E Care +31 0900 0400 063 €0.10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €0.07
Belgium E Care +32 078 250851 €0.06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Quéc gia Trung tdm

dich vu

Théng tin lién lac cho khu viec TRUNG VA DONG AU:
ASC (Trung tdm dich vu

uy quyen)

S6 chiam séc khach hang

Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV” Ltd. +371 7460399
Lithuania NA UAB “Servicenet” +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
I\S/I?)r:tlsnigro NA Kim Tec d.o.0. +381 1120 70 684
Slovenia NA PC H.and +386 1 530 08 24
- NA Comel +380 562320045
NA Topaz-Service Company |+38 044 245 73 31
Russia NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. [NA Asupport 800 100 697
NA Serware +36 1 2426331
Hungary -
NA Profi Service +36 1 814 8080

Théng tin lién lac cho khu viec CHAU MY LATINH:

Qubc gia

Brazil

Vermont

Argentina

Trung tam dich vu

S6 cham séc khach hang
0800-7254101

0800 3330 856

Théng tin lién lac & Trung Quéc:

Trung Québc

Sb cham soc khach hang: 4008 800 008

Théng tin lién lac cho khu viec NAM MY:

Quéc gia Trung tam 8 ASCUTrungitam dichivus e 5 icpamie 6e khach hang
dich vu uy quyen)

U.S.A. TOS Teleplan (877) 835-1838

Canada Supercom Supercom (800) 479-6696
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Théng tin lién lac cho khu viec Chau A TBD/Trung Dong/Chau Phi (APMEA):

Qubc gia

ASC (Trung tam dich vu

Uy quyén)

S6 cham séc khach hang

(warranty buy-out)

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / NA Smart Pixels Technology Hong Kong:Tel: +852 2619 9639
Macau Ltd. Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
Indonesia NA PT. Gadingsari elektronika | Tel: 62 21 75909053, 75909056,
Prima 7511530
South Korea |NA PCS One Korea Ltd. 080-600-6600
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics
Singapore NA Singapore Pte Ltd (Philips | (65) 6882 3999
Consumer Care Center)
PCCW
Taiwan Teleservices | FETEC.CO 0800-231-099
Taiwan
Thailand | NA ﬁ’;‘s Computer System Co., | 5671 934-5498
South Africa | NA f?’d'vara Technologies Pty | g6 0000 888
Uaned Arab NA AL SHAHD COMPUTER 00971 4 2276525
Emirates LL.C
Israel NA Eastronics LTD 1-800-567000
: : +84 8 38248007 Ho Chi Minh City
Vietnam NA (F:ErTnS:r':"'fj d'”format'c +84 5113.562666 Danang City
pany Lid. +84 5113562666 Can tho Province
I . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d!stributor and/or service
provider currently
Distributor: Computer
880-2-9141747, 9127592
Bangladesh |NA Sgtl;rce Ltd (warranty buy- 880-0-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 077-1-4229395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) 855-023-999992
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8. Khac phuc sw co &
Hoi Pap

8.1 Khac phuc sw cb

Trang nay giai quyét cac sw cd vén nguoi
dung cé thé khéc phuc. Néu sw cb van
tiép dién sau khi ban da thir dung céac giai
phéap trén trang nay, hay lién hé v&i dai
dién dich vu khach hang cta Philips.

E Cac sw cb thweng gip

Khéng c6 hinh anh (Pén LED nguén

khéng sang) .

«  Dam bao d& cam day ngudn vao 6
cam dién va mat sau clia man hinh.

«  Trwéc tién, dam bao nut ngudn &
mét tredc man hinh ndm & vi tri OFF
(TAT), sau d6 ddy nat sang vi tri ON
(BAT).

Khéng c6 hinh anh (Bén LED ngu6n

sang trang)

*  Dam bao da bat may tinh.

«  Dam bao cap tin hiéu da dwoc két nbi
dang cach véi may tinh clta ban.

*  Dam bdo cap man hinh khéng c6 cac
chéu cam bj cong trén mét két nbi.
Néu co, hay stra hay thay méi cap.

«  C6 thé da bat tinh nang Tiét kiém
nang lvong

Man hinh théong bao

Attention

Check cable connection

+ Dam bao cap man hinh da duoc két
ndi dung cach v&i may tinh cta ban.
(Ciing tham khao Huéng dan khai
déng nhanh).

+  Kiém tra xem cap man hinh cé cac
chau cdm bj cong hay khéng.

*  DPam bao da bat may tinh.
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Nut AUTO (Tw dong) khong hoat dong

« Chuc néng tw dong chi ap dung & ché
dd VGA- Analog. Néu khéng hai long
voi két qua, ban co thé thuc hién cac
didu chinh tha céng qua menu OSD
(hién thj trén man hinh).

& Ghichu
Chtrc nang Auto (Tw dong) khong ap dung
& ché d6 DVI-KTS vi n6 khong can thiét.

Cac dau hiéu vé khéi hay tia Itra c6 thé

nhin thay

+ Khéng thwe hién bat ky buwéc khic
phuc sw cb nao

+  Ngét ngay két ndi man hinh khai &
cam dién chinh cho an toan

* Lién hé ngay vé&i dai dién dich vu
khach hang cua Philips.

B cac swcé hinh anh

Hinh anh khéng ndm giiva tam man

hinh

* Chinh vj tri hinh anh qua chlrc nang
“Auto (Tw ddng)” trong cac nut diéu
khién chinh trén menu OSD.

e Chinh vi tri hinh anh qua Phase/Clock
(Géc pha/Bdng hd) cliia Setup (Cai
dat) trong cac nut diéu khién chinh
trén menu OSD. N6 chi co6 hiéu lwc &
ché do VGA.

Hinh anh rung lén trén man hinh

« Kiém tra xem cap tin hiéu da dwoc
cam chat ding cach vao bang mach
dd hoa hay may tinh hay chwa.

Hién thi hién twong chap chon doc

* Chinh hinh anh qua chirc nang “Auto
(Tw dong)” trong cac nat didu khién
chinh cdia menu OSD.



» Loai bé cac vach doc qua Phase/
Clock (Goc pha/Ddng hd) ctia Setup
(Cai dat) trong cac nat diéu khién
chinh ctiia menu OSD. N6 chi co6 hiéu
lwc & ché dd VGA.

Hién thi hién twong chap chon ngang

= —
—_—

* Chinh hinh &nh qua chc nang “Auto
(Tw déng)” trong cac nuat diéu khién
chinh ctia menu OSD.

* Loai bd céac vach doc qua Phase/
Clock (Goc pha/Ddng hd) ctia Setup
(Cai dat) trong cac nut diéu khién
chinh ctiia menu OSD. N6 chi co6 hiéu
lwc & ché do VGA.

Hinh anh hién thi nhoe, khéng ré hoic

qua mo

* Chinh d6 twong phan va do sang trén
menu Hién thi trén man hinh (OSD).

Hién twong “anh ao”, “anh thir nong”
hay “anh béng ma” van hién thj sau khi
da tat nguén.

« Hién thi lién tuc cac anh tinh trong mot
thoi gian dai co thé gay ra hién twong
“anh thr néng”, con dwoc goi la “anh
ao” hay “anh béng ma”, trén man hinh
ctia ban. “Anh th&» néng”, “Anh 30”
hay “Anh béng ma” 1a hién twong phd
bién trong cong nghé man hinh LCD.
Trong hau hét cac trwdng hop, hién
twong “anh th&r nbng” hodc “anh ao”
hay “anh béng ma” sé& dan dan bién
mat sau moét thdi gian man hinh bi
ngét dién.

e Ludn béat trinh bdo vé man hinh
chuyén ddng khi ban khoéng str dung
man hinh.

e Lubn bat (*ng dung lam m&i man hinh
dinh ky, néu khéng, man hinh LCD
cda ban sé hién thi nhirng ndi dung
tinh khong thay déi.
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» Cac hién twong “anh thir néng” hay
“anh ao0” hay “anh béng ma” sé khéng
biét mat va ban cadn mang man hinh
di stra. Thiét hai nhw trén khéng ndm
trong chinh sach bao hanh cta ching
toi.

Hinh hién thi bién dang. Van ban bi m¢

hoac nhoe.

» Cai d6 phan giai man hinh may tinh
sang cung ché dd véi do phan giai
man hinh géc khuyén dung ctia man
hinh LCD.

Cac cham luc, d6, lam, den va trang

hién thj trén man hinh

+ Céc cham con lai la d3c tinh théng
thweng clia man hinh tinh thé 16ng
dung trong céng nghé ngay nay. Vui
ldng tham khao chinh sach diém anh
dé biét thém thong tin.

Pén “bat ngudn” qua sang va gay chéi

mat

« Ban c6 thé chinh dén “bat ngudn” qua
Cai dat dén LED ngudn trong cac nut
didu khién chinh ctia menu OSD.

DPé dwoc tro gitp thém, hay xem danh
sach Trung tdm thdng tin khach hang
va lién hé va&i dai dién dich vu cham séc
khach hang cta Philips.



8.2 Héi bap chung

H1:

Khi cai cai dit man hinh, t6i cin
lam gi néu man hinh hién thi
“Cannot display this video mode”
(Khong thé hién thi ché d6 video
nay)?

Dap: Do phan giai khuyén dung cho man

hinh nay la: 1440 x 900 @60 Hz.
Ngat tat ca cac cap roi két nbi PC véi
man hinh ma ban da dung trwéc do.
Trong Windows Start Menu (Menu
kh&i dong Windows), chon Settings/
Control Panel (Cai dat/bang diéu
khién). Trong Control Panel Window
(Ctra s6 bang diéu khién), chon biéu
twong Display (Man hinh). Bén trong
Display Control Panel (Bang diéu
khién man hinh), chon thé “Settings”
(Cai dat). Trong thé cai dat, trong 6
co tén “desktop area (vung man hinh
nén)”, chuyén thanh trwot sang mirc
1440 x 900 pixels.
Mé& thé “Advanced Properties” (Thudc
tinh ndng cao) va cai Mwrc cap nhat
(Refresh Rate) sang 60Hz rdi click
OK.
Khéi dong lai may tinh va lap lai bwéc

2 va 3 dé kiém tra xem PC cla ban da

dwoc cai sang mirc 1440 x 900 @60
Hz hay chua.

Tat may tinh, ngét két ndi man hinh
cii va két ndi lai man hinh LCD Philips
clia ban.

T4t man hinh rdi bat lai PC.

H2: Mdrc cap nhat khuyén dung cho

bap:

man hinh LCD la bao nhiéu?

Murc cap nhat khuyén dung cho man
hinh LCD 1a 60Hz. Néu c6 bét ct
hién twong nhiéu nao trén man hinh,
ban cé thé cai dat mirc nay sang
75Hz @& kiém tra xem mirc méi nay
c6 loai bd duoc hién twong nhiéu
hay khong.
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H3:

Pap:

H4:

bap:

H5:

bap:

He6:

bap:

H7:

Céc file .inf va .icm trén dia CD

1a gi? Lam thé nao dé cai dat cac
driver (.inf va .icm)?

DAy la cac file driver cho man hinh
cla ban. Thwc hién theo cac chi dan
trong s tay st dung dé& cai dat cac
driver nay. May tinh c6 thé yéu cau
ban cai cac driver man hinh (file .inf
va .icm) ho&c 1&p dia driver khi ban
cai dat man hinh 1&n dau. Thyc hién
theo cac chi dan dé Iap (dia CD kém
theo) thung dwng man hinh nay. Cac
driver man hinh (file .inf va .icm) sé
dwoc cai dat ty dong.

Lam thé nao dé chinh do phan giai?
Card video/driver dd hoa cla ban
va man hinh sé ciing quyét dinh

cac do phan giai c6 san. Ban co thé
chon dé phan giai mong mudn trong
Control Panel (Bang diéu khién)
clia Windows® qua thé “Display
properties” (Thudc tinh man hinh).
Diéu gi sé xay ra néu téi quén cac
thao tac tiép theo khi dang diéu
chinh man hinh qua menu OSD?
Chi can nhan nat OK rdi chon
“Reset” (Cai dat lai) dé phuc héi moi
cai d&t mac dinh gbc.

Man hinh LCD c6 kha ning chéng
tray xwérc?

N6i chung ban khéng nén dé bé mét
man hinh va cham qua muc véi cac
vat khac hay va bao vé né khai cac
vat dung séc hay cun. Khi cdm man
hinh, d@m bao khong dung strc ép
hay lwc manh 1&n phia b& mat man
hinh. Diéu nay cé thé anh hwéng
dén cac diéu kién bao hanh cta ban.

T6i nén lau man hinh LCD nhw thé
nao?

: D& lau thong thwong, hay st dung

khan sach va mém. Dé lau ky, hay
dung con isopropyl. Khéng ding
cac dung méi khac nhw con étylic,
ethanol, axeton, hexan, v.v...



H8: T6i c6 thé thay déi cai dat mau
sac cho man hinh?
Dap: Dinhién, ban cé thé thay dbi cai

dat mau sac qua nut didu khién trén
menu OSD theo cac quy trinh sau,

. Nhén “OK” dé hién thi menu OSD
(Hién thi trén man hinh)

. Nhén “Down Arrow” (Mdii tén
xudng) @& chon tuy chon “Color”
(Mau) rdi nhan “OK” dé vao cai dat
mau; c6 ba lwa chon mau nhuw sau.

1. Color Temperature (Nhiét d6 mau);
Hai cai dat gém 6500K va 9300K.
V&i cac cai dat trong pham vi
6500K, man hinh sé hién thj “nong
vé&i tin hiéu mau dé-tréng", trong khi
nhiét do 9300K tao ra “mat va&i tin
hiéu mau lam-tréng’.

2. sRGB (Pd-Luc-Lam chuén); day
la cai d&t chudn dé& dam bao trao
ddi mau thich hop gitra cac thiét bi
khac nhau (vd: may anh KTS, man
hinh, may in, may quét, v.v...)

3. User Define (Tw chon); ngwi dung
c6 thé tw chon cai dat mau sac wu
tién bang cach chinh mau dé, luc va
lam.

& Ghi chu

Do mau anh sang téa ra ttr mét vat dung
trong khi né dwoc lam néng. Sé do nay
dwoc thé hién dwa trén ty 1& tuyét di, (mirc
dé Kelvin). Cac mirc nhiét dé Kevin thap
hon nhw 2004K la mau dé; cac mirc nhiét
dd cao hon nhw 9300K |a mau lam. Nhiét
dé trung tinh 1a mau trdng & mirc 6504K.

H9: Téi c6 thé két n6éi man hinh LCD
v&i moi PC, may cha hay may
Mac?

Co thé. TAt ca cac man hinh LCD
Philips déu hoan toan twong thich
v&i cac PC, may Mac va may ch
chuan. Ban c6 thé can co dau noi
cap dé két néi man hinh méi hé
thédng may Mac. Vui long lién hé voi
nhan vién kinh doanh cta Philips dé
biét thém thong tin.

bap:
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H10: Man hinh LCD Philips cé hé tro
chuén Plug-and-Play (Cam vao la

phat)?

DPap: Cé, cac man hinh Philips d&u hé tro
chuén Plug-and-Play twong thich
v&i Windows 7/Vista/XP/NT, Mac

OSX, Linux

H11: Anh chap ch&n hay anh thir néng
hay anh ao hay anh béng ma trén
man hinh LCD la gi?

Hién thi lién tuc cac &nh tinh trong
mot thoi gian dai cé thé gay ra hién
twong “anh th&r nong”, con dwoc
goi la “anh ao” hay “anh bong ma”,
trén man hinh cta ban. “Anh tht
néng”, “Anh do0” hay “Anh bong ma”
la hién twong phd bién trong cong
nghé man hinh LCD. Trong moi
treo'ng hop, hién twong “anh thir
néng” hay “anh ao” hay “anh bong
ma” sé& bién mét dan trong mot thoi
gian sau khi da tat ngudn.

Lubn bat trinh bao vé man hinh
chuyén dong khi ban khéng st
dung man hinh.

Luén bat rng dung lam m&i man
hinh dinh ky, néu khéng, man hinh
LCD cta ban sé& hién thi nhirng ndi
dung tinh khéng thay ddi.

® canh bao

Céac hién twgng “anh th&r nbng” hay “anh
40” hay “anh bong ma” sé& khong biét mat
va ban can mang man hinh di stra. Thiét
hai nhw trén khéng nam trong chinh sach
ba&o hanh cla ching toi.

Dap:

H12: Tai sao man hinh cua téi hién thj
van ban sic nét va cac ky tw ring
cwa?

Man hinh LCD cta ban hoat dong
tbt nhat & do phan giai gbc 1440 x
900 @ 60 Hz. P& man hinh hién thi
tdt nhét, vui long st dung dé phan
giai nay.

bap:
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